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Software Licence Agreement 
WestDev Ltd  
This document contains the WESTDEV LTD SOFTWARE LICENSE AGREEMENT which will govern the use of the Westdev 
products supplied with it. You agree to the terms of this agreement by the act of opening the sealed package which contains the 
storage media on which the software is recorded. Do not open the sealed package without first reading, understanding and agreeing 
the terms and conditions of this agreement. If you do not agree to the license conditions you may return the SOFTWARE for a full 
refund before opening the sealed package.  
1. LICENSE AGREEMENT 
Ownership of the WESTDEV Software Package and all its constituent parts supplied by Westdev Ltd ("LICENSED SOFTWARE") 
is not transferred to the Customer. Westdev Ltd hereby grants you, the LICENSEE, a non-exclusive license to have, at any time, as 
many copies of the LICENSED SOFTWARE “in use” as you have Licenses. The number of copies “in use” includes copies loaded 
into computer memory (i.e. “running”) but does not include copies loaded in a network server for the sole purpose of distribution to 
other computers. LICENSEE shall agree to have a reasonable mechanism or process in place to ensure that the number of persons 
using the LICENSED SOFTWARE at at any time does not exceed the number of Licenses granted to you. 
2. OWNERSHIP OF SOFTWARE 
As the LICENSEE, you own the magnetic, optical or other physical media on which the LICENSED SOFTWARE is originally or 
subsequently recorded or fixed, but an express condition of this License is that Westdev Ltd and/or the copyright owner retains title 
and ownership of the LICENSED SOFTWARE recorded on the original media and all subsequent copies of the SOFTWARE, 
regardless of the form or media in or on which original and other copies may exist. This License is not a sale of the original 
SOFTWARE or any copy. 
3. COPY RESTRICTIONS 
This LICENSED SOFTWARE and all accompanying written materials and all other constituent parts are the subject of copyright. 
Unauthorised copying of the LICENSED SOFTWARE, including software which has been modified, merged, or included with 
other software, or of the written materials is expressly forbidden. You may be held legally responsible for any copyright 
infringement which is caused or encouraged by your failure to abide by the terms of the License. 
4. TRANSFER OF LICENSED SOFTWARE 
The Customer may transfer the LICENSED SOFTWARE provided that (i) this Software License Agreement is transferred with the 
LICENSED SOFTWARE, (ii) the transferee fully accepts the terms and conditions of this Agreement, and (iii) all complete or 
partial copies of the LICENSED SOFTWARE, including copies on data storage devices are also transferred (or destroyed). 
5. MODIFICATION 
You may not otherwise modify, alter, adapt, merge, de-compile or reverse-engineer the LICENSED SOFTWARE, and you may not 
remove or obscure any Westdev Ltd Copyright or Trademark notices. You must use all reasonable efforts to protect the LICENSED 
SOFTWARE, diskettes, and documentation from unauthorised use, reproduction, distribution or publication, or otherwise in 
violation of applicable law. Please contact our Customer Service department if you become aware of violations of Westdev Ltd's 
Copyright. 
6. TERMINATION 
The License is effective until terminated. You may terminate it at any time by destroying the LICENSED SOFTWARE and all 
complete or partial copies thereof. It will also terminate if you fail to comply with any term or condition of this Agreement. You 
agree upon such termination to destroy the LICENSED SOFTWARE and all complete or partial copies thereof. 
7. WARRANTIES 
No warranties are expressed or implied with respect to the LICENSED SOFTWARE described, its quality, performance, accuracy 
or suitability for any purpose. In no circumstances will the copyright holder be liable for direct, indirect, incidental or consequential 
damages resulting from the use of this SOFTWARE. 
8. OTHER SOFTWARE 
The supplied disks may contain software whose copyright is owned by third parties. This license agreement shall apply equally to 
this software except where the terms of this agreement are specifically modified by the copyright holder(s). Such modification(s) 
will be included in a machine readable file on the supplied media. 
9. GOVERNING LAW 
The Governing Law of this Agreement shall be that of England. 
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Chapter 1. Getting Started 
Introduction 

Stockit version 1.6 provides new and additional features to those available in the previous version 
of the product. It also consolidates all fixes for problems reported since the previous update 
release. The changes made are listed in the following chapters. 

Installing the New Version 

This update is provided as a self-unpacking installation program that will automatically start the 
Setup program needed to install the modified files. Installation will start automatically once 
download from the Internet is complete or from the installation CD. 

Backup your Database first 

Although installing the new version does not affect your existing database it is highly 
recommended that you make a separate backup copy of your database to another location before 
you install the new version. 

Operating System Support for Windows 7 

Stockit version 1.6 is now fully supported under Windows 7.  

Note: No versions of Stockit earlier than version 1.6 can be supported under the Windows 7 
operating system.  
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Chapter 2. Functional Changes 
Updated User Interface 

Customisable Toolbars and Shortcut keys 

Clicking the Customise… button on the Stockit furniture (the edge of the program window) or 
from the Tools menu will open up the Customise dialog.  

 
From this dialog, you can customise various aspects of the Stockit program, for example, shortcut 
keys, toolbar buttons or tooltips. 

Customise dialog 

The Commands dialog is used to add any command used in Stockit onto a Toolbar or menu. 

Within the Commands tab, there is a list of command Categories each of which will display a list 
of commands when selected. The All Commands item (at the bottom of the Categories list) will 
show all commands in all categories. Selecting a category, lists all the commands defined in that 
category.  

Selecting a command will display a description of it's function. A selected command may be 
dragged, by pressing and holding down the left-hand mouse button, and dropped on to any visible 
toolbar or menu. Dragging the command over a menu bar item will cause the corresponding menu 
to drop down allowing the command to be placed within that menu. The same command may be 
placed on more than one toolbar or menu.  
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Customising Toolbars 

Within the Toolbars tab you may change toolbar visibility, add new toolbars, delete existing 
custom toolbars and reset default toolbars. A new custom toolbar will appear, 'floating' over the 
application main window, ready to have your chosen commands dragged on to it. Alternatively 
click Cancel to abort the creation of a new toolbar. 

 
How to create a new user defined Toolbar 

The Toolbar Name dialog appears when the New button on the Toolbars tab is clicked. Enter the 
name of the new toolbar then click OK to confirm you wish to create the toolbar.  

 

Shortcut Keys 

Shortcut keys offer an alternative method of performing actions for users who prefer the keyboard 
to the mouse. Any command may be assigned to a given key or keyboard combination. The 
command can then be performed simply by entering the assigned shortcut key.  

The application comes with a predefined set of Shortcut Keys for its most commonly used 
operations. These are however, only a default set and may be changed, removed or added to 
according to your own personal preferences using the Keyboard tab on the Customise dialog.  

If a command, to which a Shortcut Key is assigned, is available from a menu, the Shortcut Key 
combination is displayed alongside the option in the menu. Also, optionally Shortcut Keys can be 
shown in the tooltips, displayed for toolbar buttons.  

Modifying Shortcut Keys using the Keyboard dialog 

The Keyboard dialog allows you to query, remove or add to the Shortcut Keys currently assigned 
to commands.  
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The Category: list, in the top left of the dialog, allows you to restrict the list of commands shown 
to only those in the chosen category. Select All Commands from the drop down list to see a 
complete list.  

The Commands: list shows the commands to which you can assign a shortcut key. The currently 
selected command is shown in the box at the top of the list.  

The Description box displays a brief description of the currently selected command.  

The Current Keys list shows any shortcuts currently assigned to the command. You can assign 
more than one shortcut to the same command, but you cannot assign the same shortcut to different 
commands. Clicking the Remove button removes the currently selected shortcut.  

You can also identify a command by its currently assigned shortcut. To do this, type the key or 
key combination (Ctrl+C, for example) into the Press New Shortcut Key: box. If a command is 
a assigned, it will be displayed below Assigned to: as text.  

Assigning Shortcut Keys 

To assign a shortcut, place the cursor into the box positioned below the prompt Press New 
Shortcut: Key, then press the desired key combination. Clicking the Assign button will assign 
this shortcut key to currently selected command. If the key is already assigned to another 
command it will be displayed below Assigned to:  

The Reset All button resets all shortcuts to the shortcut defaults. 

Customise Menu 

Use features on this tab to define how the menus look and to reset them to the default settings. 
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Show Menus for: there is a standard set of menus currently in Stockit and this will always be 
shown as the Default Menu in the drop down list.  

Reset This button will reset the Default Menu back to its original default settings. Any user 
customisation will be lost. 

Menu animations: this allows you to define how the menus are revealed once selected. You can 
choose Unfold, Slide and Fade as possible options from the drop down list.  

Menu shadows this specifies whether or not a menu is displayed with a shadow. 

Customise Options 

Use this tab to define how the Toolbar will look.  

 
Toolbar 

Show ScreenTips on toolbars 

This specifies whether or not tooltips are to be shown when the mouse pointer is over toolbar 
buttons or not. 

Show shortcut keys in ScreenTips  

This specifies whether or not the tooltips should include equivalent shortcut keys for toolbar 
buttons where defined. 

Large Icons 

This specifies whether or not toolbars should be displayed with the larger size icons. 

Updated User Interface 

The user interface has been updated in several respects. 
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Tabbed Windows 

Tabbed windows have been added for improved speed of access to open forms. The window tabs 
are displayed across the top of the interface just below the default positions of the menu and 
toolbars, and show the form name. The current active window, the one at the front, is shown in 
bold type-face. To move easily between each open form, simply click on the tab to bring it to the 
front. 

 
These tabbed windows can be switched off if not required by selecting the Tabbed Windows 
option from the View menu. A ‘tick’ mark will be displayed next to the menu option to indicate 
whether it is active or not. 

 
By default, tabbed windows will operate with each of the form windows maximised within the 
application window, but this is not compulsory. The form windows can be switched to a Cascade 
or Tiled layout by using the options available on the Windows menu. 

Easy Access to Users Guides 

The Help menu now includes entries for PDF versions of the  Stockit Users Guide and V1.6 
Updates Notes. To access these, simply select the manual required from the sub menu under 
Manuals>.  To view these PDF files, you will need the Adobe Acrobat viewer installed. This is 
available free of charge from www.adobe.com  

 

 

www.adobe.com
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User Defined Attributes 

There is a new Attributes table available for Stock items. This can be used in addition, or instead 
of the three user-defined fields on the Stock form. 

The 'key' field used for this form is the Part Number, you can sort by Part Number but you are not 
able to edit it from here. When a stock item is selected from the Stock form, it will be pre-selected 
in this form for ease of locating. 

 
Working with Attributes Names 

There are two aspects to an attribute; the attribute name (Tol, Wattage, Value etc.) and its value 
(100K, 2%, 5%, 0.25W etc.).  

To add a new attribute name, click once on the attribute header New... and type the name 
required, then either press <Enter> or select another cell in the grid to accept the name. The name 
will change to a bold font to show it has been accepted.  

To delete an Attribute Name (and the column under it plus any assigned values in that column), 
select the attribute name and press the <Del> key on the keyboard. The column will be removed.  

Editing Attribute Names 

Attribute Names can be edited by selecting the name and using a <Ctrl+double-click>. Edit the 
name once highlighted then press <Enter> to accept it. 

Working with Attributes Values 

To add a new attribute value, click once on the corresponding attribute/stock item cell. Type in 
the value required. Press <Enter> or select another cell to confirm the value. Values can be 
numeric or alpha characters or a combination of both.  

To edit a value, use a single click on the cell and type the new value. This will replace the whole 
value. To modify the existing value, double-click in the cell and use the left and right keys on the 
keyboard or position the cursor within the text string. Make the edit then press <Enter>. The 
<Del> and <Backspace> keys can also be used to edit the text.  

To delete an Attribute Value, select the value or multiple-select values and press the <Del> key 
on the keyboard. You can also use <Ctrl+select> or <Shift-select> to pick multiple cells. Once 
selected, you can delete their values or Paste in new ones.  
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Using Copy/Paste in the grid cells 

Copy and Paste can be used to add values into single or multiple cells at the same time. Copied 
values can be pasted into selected cells in columns and across rows or both. Copied values can be 
taken from within the Attributes form or from an external source, such as Excel or Notepad for 
example.  

To paste the same value into multiple cells, copy the value required first. Select the cells required 
in the attribute grid and press the shortcut <Ctrl+V> (Paste) from the keyboard or the Paste 
option from the Edit menu.  

Undo and Redo in the Attributes form 

Undo and Redo can be achieved using the shortcut keys <Ctrl+Z> or <Ctrl+Y> and will 
undo/redo any attribute names or values entered. These two commands are only available in this 
form. They are only available until the Save button is pressed or until the Close/Cancel button is 
pressed. Redo does not remember previous editing sessions, only the current one.  

Sorting Columns 

You can sort any column by double-clicking on the Attribute header. Double-clicking the first 
time will sort the list in ascending order, double-clicking it again will sort it in the opposite 
direction, i.e. descending.  

 
Saving Attributes 

Once you have finished adding or editing attributes, you must save them. To do this, click the 
Save button at the top of this form. Once pressed, the button will be greyed out and the Close 
button will be active, use this button to close this form.  

Before Save has been pressed, the Close button will show as Cancel. Use this to close the 
Attributes form without saving the attribute names or values from your current session.  

All Stock Items uncheck this check box to only show the Stock items which have attributes 
attached to them. Any stock item that has at least one attribute value will be displayed in this list. 
To add attributes to items not shown it is necessary to switch back to All Stock Items mode. 

Searching by Attribute Names 

Unlike the three user-defined fields on the Stock form, the fields in the Attributes table cannot at 
present be used for searching and filtering of the stock form. This is also the case in the Report 
Builder. 

Hyperlink Attributes 

A value added for an attribute can be a hyperlink containing a reference to a web page, an 
external document or an executable program, this referenced item can exist on the Internet.  

A hyperlink can be specified as a full path e.g. c:\temp\datasheet.pdf or C:\Documents and 
Settings\All Users\Documents\Stock\part.doc, or can be entered relative to the database location, 
e.g. documents\datasheet.pdf.  Say, for example, you want to view images of your stock items and 
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your database is located at c:\db, you could set up a folder of image files at c:\db\pictures and then 
reference them using an attribute with a relative path such as pictures\part.gif.  

 
To activate a hyperlink, position the cursor over the attribute value then press <Ctrl+click>. 

For a hyperlink to reference an executable program, it must include the .exe extension in the file 
name which must be reachable by the system, e.g. notepad.exe. The executable can be 
accompanied by parameters which, if specifying a path to a file, may be a relative path as 
described above, e.g. excel.exe info\part.xls. 

Copying values from the grid 

Where a grid is used to displays records, clicking on a row generally selects and highlights the 
entire row of information. Using the Copy command, or its shortcut key (<Ctrl+C> by default), 
will copy the entire row of text to the Windows clipboard. If you wish to copy the text from a 
single field in the record, perhaps to paste into a search or filter elsewhere, right-click over the 
value and select Copy Value from the context menu.  

 

Report Builder Improvements 

The Report Builder has been enhanced to include three new additional information sources; 
Attributes, Stock Attributes, Parts List Stock Attributes and Job Shortages. These can be 
selected from the Select Information From drop down list as the basis for your report. 
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Selecting Attributes will allow fields from the new Attributes table to be reported for stock 
items. Using Stock Attributes will additionally allow fields from the Stock table to be combined 
with those from Attributes and reported. The Parts Lists Stock Attributes selection will enable 
you to write out all Stock Attributes associated with a particular Parts List. The Job Shortages 
selection is useful because it allows you to report shortage information combined with additional 
fields from the Stock table such as current stock level or any of your custom fields. 

FIFO Calculation in Update Stock Costs from Goods-In Costs 

A new Average Goods In calculation has been added to the Update Stock Costs From Good In 
Costs dialog. This will give you an average goods-in value of your current stock based on the 
First In First Out principle (FIFO).  

 
This is calculated as the average unit cost of just the Goods In records relating to the items still 
currently in stock, assuming stock is booked out on a First In First Out basis.  

For example, if the most recent deliveries of part M3 were:  

10 on 8th Feb @ £5 
5 on 6th Feb @ £4 
20 on 4th Feb @ £3 
30 on 2nd Feb @ £2 
50 on 1st Feb @ £1 

And the current stock level for M3 is 30, the updated cost would be calculated as: 

(10 * 5) + (5 * 4) + (15 * 3) 

-------------------------------- = 3.833 

 30 

Using this option means the updated cost is not skewed by the cost of the earlier deliveries whose 
items have been already been issued.  
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Partial Ordering 

On the New Purchase Order Items page (on the Stores menu), the option to place the purchase 
orders can now be run selectively with the added option to mark items for individual ordering. 

By marking items, you can run partial ordering, for example if some known items are on long 
lead times. 

 
Marked Items Only 

When 'checked', this option allows you to process only certain items in the form and leave the 
others to do another time. In the grid there is a corresponding column of checkboxes which are 
used to mark the items you wish to include. The checkbox at the head of the column will check or 
uncheck all items in a single action.  

With the required items marked, the Place Items as Orders, Request Quotes for Items and 
Clear Items actions, shown in the box alongside Marked Items Only, will only operate on those 
marked items and leave all unmarked items unaffected. 

If the form is closed, any item marked will remain marked when the form is next re-opened. 

Clear Items 

This option allows you to quickly remove all the purchase items shown, effectively clearing your 
"shopping list", unless the Marked Items Only option is in use in which case only marked items 
will be cleared. 

Multiple Partial Orders 

It is now possible to add multiple occurrences of the same Part Number to the list of items to be 
ordered. This will enable you to create separate order quantities of the same item and schedule 
them for different delivery dates. 
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Fast Searching Improvements 

Priming the Navigation bar 

Clicking a column header in the grid will now additionally prime the column as the current search 
field in the Navigator Bar.  

 
Find Next 

Also, having found the first matching record when the search value was typed, it is now possible 
to find the next and subsequent matching records by typing <Ctrl+Enter> (similar to the Find 
Next button when using  the Search dialog).  This can be useful when searching columns which 
are not the current sort field. 

Additions to the Import Wizard 

When using the Import Wizard, you can now additionally import data for Parts Lists and the 
new Attributes table. 
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For example, Parts List Contents data showing the fields that can be mapped in the Import 
Wizard, can be generated using Stockit’s Report Builder with the Parts List Contents source 
setting. A sample Parts List Contents output is shown below: 

 

Character Increases from 100 to 255 

The size of the Ref field in Parts Lists has been increased from 100 to 255 characters. The 
increase will be automatically performed when you run your existing database in the Version 1.6. 

Connection to the Pulsonix PCB Design System 

You can now connect Stockit to Pulsonix using the Pulsonix Database Connection option. Using 
the Attribute fields, you can add Component information to the Stockit database to make your 
stock records more meaningful. Information such as tolerance, height, wattage, value etc, can be 
added to the stock item (Part). 

How to connect the PDC to a Stockit database 

From the Connection To Database: options, you need to select the connection type and path to 
the database. 

 
Next to the Connection Type: box, select the Change button. From the drop down list, select 
Stockit Database (*.mdb) file option. 

 
Now select the Stockit database using the Browse button to locate it. 
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Once the database type and location have been established, you will automatically be connected 
to the database and the relevant tables and fields will be setup automatically. Although you can, if 
you wish to, restrict which Stockit attributes are copied into your Pulsonix design. 

 
The connection option will display the Database Tables and Mappings options. On Table 
Name: select either the Attributes or Stock Attributes tables depending on your preference of 
operation. Attributes gives you access to the part number and attributes names/values you have 
defined. Stock attributes additionally gives you access to the fields defined for the Stock table 
(except for the three user-defined fields). 

Use the mappings to define what you wish to use for Pulsonix search fields in the PDC. 

 
The PDC searcher will now display the fields available for searching: 
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Extracting Attributes 

Attributes and stock values from Stockit can be passed into a Pulsonix design. You can verify 
which attributes have been used by selecting a component in the design and viewing its Comp 
Attribute Properties. 

Once in the design, attributes can be extracted using the normal Report Maker mechanism. 

Creating Stockit format Parts Lists from Pulsonix 

In order to run Stockit through a complete purchase cycle, you must create a Stockit Parts List. 
This is used to pull stock items from the Stockit database and process them using the Stockit 
option available. 

Once in the design, attributes can be extracted using the Pulsonix Report Maker mechanism. 
They can also be compared against their original values in the database using the Pulsonix 
Check/Update Against Database mechanism. 

When run, this will create a CSV file suitable for Stockit. To load this into Stockit, from the File 
menu, Import >, from the sub-menu, select Parts Lists. 

 
Import your parts list; this will then appear on the Parts Lists form in Stockit with a 
corresponding entry in the Stock form. 

 

 


